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Today,	were	diving	into	conditional	formatting	rules.	Why?	Well,	to	answer	a	question	I	received	recently,	which	is	basically:	I	want	a	cell	to	be	conditionally	formatted	based	on	the	value	in	another	cell	where	the	criteria	is:	if	cell	C7	is	up	to	10%	less	than	D7	then	have	a	yellow	color	and	if	its	more	than	10%	less,	then	red.	How	is	such	a	formula
written	in	the	conditional	formatting	tab?	This	is	essentially	asking	how	to	conditionally	format	variances	between	two	values,	and	Im	going	to	answer	that	question	in	this	post.	In	general,	conditional	formatting	is	a	useful	skill	for	those	who	like	to	provide	a	visual	way	to	distinguish	between	values	based	on	one	or	more	conditions.	The	steps	provided
in	this	post	intend	to	ensure	a	deep	understanding	so	that	you	can	easily	tailor	the	rules	to	your	specific	needs.	Well	embark	on	this	journey	in	a	step	by	step	manner	using	three	exercises	to	understand	how	to	create	the	rules	and	how	to	manage	them.	Firstly,	lets	warm	up	with	conditional	formatting	and	discover	how	to	apply	multiple	conditional
formatting	rules.	This	essentially	means	applying	multiple	conditions	to	a	single	range.	Lets	say	we	have	a	range	of	cells	that	we	want	to	conditionally	format	based	on	these	rules:	If	the	cell	value	is	less	than	or	equal	to	200,	apply	a	red	format	If	its	between	500	and	700	inclusive,	apply	an	orange	format	If	its	greater	than	or	equal	to	800,	apply	a
green	format	To	apply	these	rules	in	Excel,	begin	by	selecting	the	entire	range	you	want	to	format.	Then	click	Home	>	Conditional	Formatting	>	Manage	Rules.	This	opens	the	following	dialog:	Then	do	the	following	steps	for	each	rule	youd	like	to	create	for	the	range:	Click	New	Rule	Select	a	rule	type,	such	as:	Format	only	cells	that	contain	Define
your	criteria	Click	Format	to	define	the	format	to	apply	when	the	condition	is	met	The	rule	may	look	something	like	this:	Click	OK	to	close	and	then	you	can	repeat	these	steps	to	add	multiple	rules	to	the	same	range	of	cells.	When	complete,	the	manage	rules	dialog	should	show	all	rules:	Click	OK	and	bam:	Now	that	we	are	warmed-up,	lets	head	to	the
next	exercise.	Next,	lets	dig	into	how	to	calculate	a	variance	column	in	Excel	and	apply	conditional	formatting	to	it.	The	Variance	column	uses	the	formula	logic	of	(Current	Prior)	/	Prior.	We	want	any	decreases	up	to	10%	to	be	highlighted	in	yellow,	while	decreases	greater	than	10%	should	be	marked	in	red.	Our	worksheet	looks	something	like	this:
We	begin	by	selecting	the	Variance	range,	and	then	Conditional	Formatting	>	Manage	Rules.	Then	we	create	the	following	two	rules:	If	the	cell	value	is	between	0	and	-0.1,	apply	a	yellow	font	color.	If	the	value	is	less	than	-0.1,	apply	a	red	font	color.	The	dialog	will	look	something	like	this:	Apply	and	bam:	And	that	works	well	when	you	want	to	show
the	variance	in	a	column.	In	practice,	this	is	extremely	common.	However,	there	may	be	times	when	you	want	to	apply	the	formatting	to	the	values	without	needing	to	compute	or	display	a	Variance	column.	Can	we	do	that?	Yes	and	we	will	in	the	next	exercise.	This	exercise	shows	how	to	apply	the	same	conditional	formatting,	but	without	needing	to
display	a	Variance	column.	Essentially,	we	will	take	the	basic	variance	calculation	and	embed	it	directly	into	our	conditional	formatting	rule.	Select	the	range	you	want	to	conditionally	format.	Then	Conditional	Formatting	>	Manage	Rules.	This	time,	our	new	rule	will	use	the	Use	a	formula	to	determine	which	cells	to	format	option.	We	write	a	formula
that	will	return	TRUE	when	we	want	the	corresponding	format	applied.	When	we	are	writing	our	formula,	we	need	to	be	sure	(a)	to	use	absolute	column	references	by	preceding	them	with	a	dollar	sign	like	$C11	and	(b)	the	row	reference	matches	the	row	of	the	active	cell,	in	this	case	11.	For	example,	if	the	Active	Cell	in	our	selection	was	11,	the
current	value	is	column	C,	the	prior	value	column	is	D,	and	we	want	to	apply	the	specified	format	to	cell	values	less	than	-10%,	the	following	formula	will	work:	=(($C11-$D11)/$D11)	New	Rule	->	Use	a	formula	to	determine	which	cells	to	format	->	Format	values	where	this	formula	is	true:=C2/B2>10%format	red	repeat	the	steps	but	do	this	formula
for	green:=C2/B210%	Thanks,	if	you	have	clicked	on	the	*	and	added	our	rep.	If	you're	satisfied	with	the	answer,	click	Thread	Tools	above	your	first	post,	select	"Mark	your	thread	as	Solved".	"Contentment	is	not	the	fulfillment	of	what	you	want,	but	the	realization	of	what	you	already	have."	Tips	&	Tutorials	I	Compiled	|	How	to	Get	Quick	&	Good
Answers	08-24-2023,03:13	PM	#1	Hello	all	-	I	am	working	on	a	project	for	my	company	and	need	assistance.	I	need	a	conditional	formatting	formula	that	will	take	the	average	percentage	in	a	column	from	say	C3:C80,	and	highlight	any	numbers	that	are	greater	or	less	than	20%.	For	example,	if	the	average	for	a	particular	month	is	64.80%,	then	it
would	highlight	everything	exceeding	the	numbers	that	are	20%	higher	or	lower	than	the	64.80%.	Been	playing	with	different	formulas	all	morning	and	cannot	get	them	to	work.	Thanks.	Dave	08-24-2023,03:25	PM	#2	Fast	answers	need	visual	help.	Please	read	the	yellow	banner	at	the	top	of	this	page	on	how	to	attach	a	file	and	a	mocked	up	solution.
Trevor	Shuttleworth	-	Retired	Excel/VBA	Consultant	I	dream	of	a	better	world	where	chickens	can	cross	the	road	without	having	their	motives	questioned	'Being	unapologetic	means	never	having	to	say	you're	sorry'	John	Cooper	Clarke	08-24-2023,03:34	PM	#3	Hello	-	Attached	is	my	mockup	Excel	Sheet	with	my	fake	numbers	and	an	average	of	all	the
numbers.	Hope	this	helps.	Dave	Attached	Files	Excel	Forum	Demo.xlsx	(9.7	KB,	5	views)	Download	Last	edited	by	davidingilbert;	08-24-2023	at	04:03	PM.	08-24-2023,04:10	PM	#4	Use	the	CF	formula	Formula:	Please	Login	or	Register	to	view	this	content.	08-24-2023,04:32	PM	#5	It	is	working.	Thank	you.	Dave	08-24-2023,04:33	PM	#6	You're
welcome.	If	that	takes	care	of	your	original	question,	please	select	Thread	Tools	from	the	menu	link	above	and	mark	this	thread	as	SOLVED.	Also,	you	may	not	be	aware	that	you	can	thank	those	who	have	helped	you	by	clicking	the	small	star	icon	located	in	the	lower	left	corner	of	the	post	in	which	the	help	was	given.	By	doing	so	you	can	add	to	the
reputation(s)	of	those	who	helped.	08-24-2023,04:51	PM	#7	Hello	Again	-	I	am	having	one	issue	with	the	formula	you	provided	me.	When	I	input	it	into	my	Excel	Sheet,	it	does	not	highlight	all	the	items	that	are	20%	higher	than	the	average.	Gets	most	of	it,	but	not	all	of	it.	I	have	attached	an	updated	copy	of	my	Excel	Forum	Demo	so	you	may	see	what
I	am	referring	to.	Thank	you.	dave	Attached	Files	Excel	Forum	Demo.xlsx	(11.5	KB,	4	views)	Download	08-24-2023,06:05	PM	#8	I	have	attached	an	updated	copy	of	my	Excel	Forum	Demo	so	you	may	see	what	I	am	referring	to.	Given	that	there	is	no	CF	in	this	sample	workbook,	I	do	not	know	to	what	you	refer.	Column	C	works	as	expected.	The
average	of	the	values	in	column	D	is	zero;	in	fact,	a	very	small	number	slightly	less	than	zero	(	-0.002179487179%,	give	or	take).	Plus	or	minus	20%	of	that	very	small	number	is	still	going	to	be	very	close	to	zero.	Please	see	the	updated	sample	file.	Attached	Files	Excel	Forum	Demo	TMS.xlsx	(13.3	KB,	3	views)	Download	Nothing	makes	information
stand	out	like	a	little	bit	of	color.	Excel	has	a	tool	that	automatically	helps	you	out	with	that	its	called	conditional	formatting.	If	youre	ready	to	take	your	data	organization	game	to	the	next	level,	keep	reading	to	learn	how	to	use	conditional	formatting	in	Excel.	In	this	resource,	we'll	apply	conditional	formatting	to	a	pivot	table.	Note	that	the	steps	to
apply	pivot	table	conditional	formatting	are	the	same	as	applying	it	to	data	in	other	formats,	so	the	instructions	below	will	still	work	for	you	for	any	data	in	your	range	or	table.	Conditional	formatting	in	Excel	is	a	tool	that	applies	formatting	to	your	data	depending	on	the	conditional	rules	you	lay	out.	It	can	be	used	in	a	number	of	ways,	including
visualizing	your	data	and	checking	for	specific	information.	Additionally,	its	a	great	way	to	highlight	top	values	or	differences	in	your	data.	Download	your	free	Excel	practice	file!	Use	this	free	conditional	formatting	Excel	file	to	practice	along	with	the	tutorial.	When	to	use	conditional	formatting	You	can	use	conditional	formatting	in	Excel	to	visualize
month-over-month	marketing	statistics,	highlight	link	building	opportunities	by	difficulty,	or	color-code	content	calendars.	Conditional	formatting	can	also	tell	you	when	inventory	levels	fall	below	a	certain	number,	your	top	ten	selling	products	for	the	month,	which	tasks	in	your	tracking	sheet	are	incomplete,	and	so	much	more.	Why	use	conditional
formatting?	With	conditional	formatting,	you	have	a	variety	of	rules	at	your	disposal	to	customize	your	data	according	to	your	needs.	You	can	generate	rules	for	text,	values,	and	even	dates.	Text	Rules:	Is	a	cell	empty	or	not	empty	Does	Text	contain	or	not	contain	something	Does	Text	start	with	or	end	with	something	Is	Text	exactly	equal	to	something
Date	Rules:	If	a	Date	is	If	a	Date	is	before	If	a	Date	is	after	something	else	Value	Rules:	Is	a	Value	greater	than	or	equal	to	Is	a	Value	less	than	or	equal	to	Is	a	Value	equal	to	or	not	equal	to	Does	a	Value	fall	between	or	not	between	other	values	Now	that	youve	been	introduced	to	the	conditions	used	at	the	core	of	conditional	formatting,	lets	talk	about
how	you	can	apply	them	to	your	data.	How	to	use	conditional	formatting	Lets	apply	conditional	formatting	to	this	pivot	table	of	traffic	data	from	Google	Analytics,	where	our	eventual	goal	is	to	only	look	at	the	top	15	countries.	Conditional	formattings	various	forms	can	help	us	highlight	the	most	significant	points	in	our	pivot	table,	whether	its	top
values	or	relative	data	point	differences.	Here	are	three	versions	of	conditional	formatting	and	how	to	apply	them.	Icon	Sets	Data	Bars	Top/Bottom	Rules	Icon	sets	Instead	of	spending	hours	sifting	through	an	endless	array	of	values,	if	only	there	were	an	easy,	visual	way	to	help	you	break	up	your	data	in	Excel.	Lucky	for	you,	weve	got	just	the	thing:
icon	sets!	Icon	sets	are	exactly	what	youre	thinking	small	images	we	can	use	to	organize	our	data	and	its	super	easy	to	use	them	in	Excel	with	conditional	formatting.	To	start:	Highlight	the	column	you	want	to	organize,	then	go	to	the	Home	tab.	Click	Conditional	Formatting,	then	select	Icon	Set	to	choose	from	various	shapes	to	help	label	your	data.
For	this	example,	lets	use	the	arrow	icon	set	to	show	whether	our	highlighted	data,	the	Variance	column,	has	increased	or	decreased.	Now,	youll	see	that	the	data	has	arrow	icons	accompanying	their	values	in	the	cells.	Looking	at	the	data	though,	the	arrows	are	not	accurately	showing	increases	and	decreases	in	data	as	expected.	We	want	our	data	to
show	positive	percentages	as	increases	and	negative	percentages	as	decreases.	This	brings	us	to	editing	rules	in	conditional	formatting,	which	is	key	to	taming	your	data.	To	change	the	rule:	Select	your	data	again,	then	go	back	to	Conditional	Formatting.	Select	the	bottom	option,	Manage	Rules.	Youll	be	shown	the	rule	you	just	implemented,	which
was	applied	with	the	default	values	set	in	Excel.	Click	on	the	rule,	then	select	Edit	Rule	to	change	the	values	your	rule	will	follow.	You	can	change	how	your	icons	are	displayed	based	on	the	values	set	here.	Download	your	free	Excel	practice	file!	Use	this	free	conditional	formatting	Excel	file	to	practice	along	with	the	tutorial.	Lets	go	back	to	our
example,	which	calls	for	our	icons	to	show	Variance	increases	and	decreases.	To	do	this:	Set	the	green	arrows	Value	to	0.01	and	Type	to	Number	to	show	all	increases.	Then	set	the	yellow	arrows	Value	to	0	and	Type	to	Number	so	that	when	the	Variance	is	between	0.01	and	0,	this	means	that	there	was	no	change.	Red	arrows	will	be	shown	when	the
Variance	is	below	0.	Once	youre	done,	click	OK,	and	then	you	can	click	Apply	before	you	exit	this	screen	to	put	the	rule	in	place.	Click	OK	once	more	to	finalize	your	edits.	With	that,	youll	see	that	your	wonderful	set	of	arrows	is	accurately	indicating	all	of	the	changes	in	your	Variance	data.	Data	bars	Another	way	to	display	conditional	formatting	in
your	data	is	with	data	bars.	If	you	highlight	a	column	and	apply	data	bars,	you'll	see	that	they	appear	in	the	column.	Using	this	method,	its	easy	to	visualize	your	data	relative	to	other	values:	the	bigger	the	data	bar,	the	bigger	the	value.	You	also	have	a	choice	between	using	a	gradient	or	solid	color	bar	in	your	visualization.	In	our	table,	lets	apply	data
bars	to	the	Aug-20	column.	You	can	easily	do	this	by	going	to	Conditional	Formatting,	clicking	Data	Bars,	then	selecting	any	of	the	available	bar	fills.	Top/bottom	rules	Top/bottom	rules	are	another	cool	way	to	use	conditional	formatting.	This	allows	you	to	organize	your	data	based	on	the	highest	or	lowest	values	in	your	data	set.	From	there,	you	can
further	hone	your	data	set	by	focusing	on	the	values	you	care	about	most.	Lets	say	you	want	to	see	the	top	three	countries	in	the	Sep-20	Sessions	column	displayed	in	green	text	with	a	green	fill.	Select	Top/Bottom	Rules,	then	click	Top	10	Items.	A	window	will	pop	up,	where	you	can	then	indicate	the	number	of	cells	that	rank	in	the	top.	Change	the
number	10	to	3,	then	select	Green	Fill	with	Dark	Green	Text.	Once	you	hit	OK,	your	pivot	table	will	now	highlight	those	top	three	values	in	the	color	you	chose.	You	can	now	see	that	the	United	States	qualifies	as	one	of	the	top	three	values.	Since	the	list	of	countries	is	quite	large,	you	can	also	use	the	Top	Ten	rules	to	make	the	pivot	table	smaller	and
more	digestible.	For	this,	navigate	to	the	Row	Labels	header	dropdown.	Click	Value	Filters,	then	select	Top	10	again.	Edit	the	value	10	to	however	many	items	you	want	to	display	in	the	pivot	table.	Heres	what	the	pivot	table	looks	like	when	its	condensed	to	the	top	15	countries.	Notice	in	the	image	above	the	Row	Labels	and	Column	Labels	header
drop-downs	are	missing.	For	a	cleaner	look	to	your	pivot	table,	you	can	hide	your	row	label	and	column	labels.	On	the	Pivot	Table	Analyze	tab,	just	click	Field	Headers	to	make	them	disappear.	To	make	them	appear	again,	just	click	on	the	same	button.	So	there	you	have	it:	a	pivot	table	showing	data	bars,	the	top	three	countries	in	green,	and
highlighted	variance	increases	and	decreases	all	thanks	to	conditional	formatting.	And	the	nice	thing	about	conditional	formatting	is	that	when	your	data	changes,	the	rules	you	set	in	place	adapt	right	with	it	too.	Level	up	your	Excel	skills	Conditional	formatting	does	wonders	in	helping	you	to	visualize	your	data,	and	its	use	cases	are	endless.	To	learn
more	about	conditional	formatting	and	other	versatile	Excel	skills	you	can	use	to	format	and	analyze	your	data,	make	sure	to	check	out	GoSkills	and	HubSpots	free	Excel	for	Marketers	Crash	Course.	Level	up	your	Excel	skills	Become	a	certified	Excel	ninja	with	GoSkills	bite-sized	courses	Start	free	trial	Today,	well	highlight	recurring	values	within	a
dataset	in	order	to	answer	a	recent	question.	I	was	asked	the	following	Im	trying	to	get	it	to	recognize	if	a	specific	letter,	like	X,	is	in	a	column	at	least	three	times.	What	could	the	formula	look	like?	And	Ill	answer	that	question	in	this	post.	Lets	just	dive	in!	Well	walk	through	a	series	of	three	exercises	to	demonstrate	the	key	elements.	First	we	need	to
understand	how	to	determine	how	many	times	a	cell	matches	a	specific	value.	Well	use	the	COUNTIF	function	since	it	has	been	around	forever	and	is	available	in	just	about	every	Excel	version	in	use	today.	Specifically,	COUNTIF	counts	the	number	of	cells	that	match	the	value	we	are	seeking.	It	does	not	count	the	number	of	times	the	matching	value
is	found.	When	each	value	is	found	within	a	cell	only	once,	this	is	the	same	count.	But,	when	the	value	we	are	seeking	is	found	multiple	times	within	a	single	cell,	the	count	will	be	different.	In	other	words,	if	we	are	looking	for	the	letter	x,	and	it	is	found	two	times	in	one	cell,	COUNTIF	will	return	1	because	it	has	been	found	in	that	cell.	COUNTIF	is
counting	cells.	I	provide	other	formula	variations	below	in	case	you	need	different	logic.	Lets	provide	an	illustration.	Consider	the	range	below.	We	would	like	to	count	the	number	of	times	a	given	letter,	say	x,	is	found	within	the	range.	We	type	the	letter	we	are	trying	to	find	into	a	cell,	like	C6,	and	then	write	the	following	formula	in	a	cell	like	C8:
=COUNTIF(B12:B21,C6)	This	counts	the	number	of	cells	within	the	range	B12:B21	where	the	cell	matches	cell	C6.	In	our	case	it	returns	4	since	x	is	the	cell	value	for	4	cells:	So,	to	reiterate,	this	formula	counts	the	number	of	cells	where	the	cell	value	matches	C6.	Depending	on	what	you	are	working	on,	you	may	want	a	variation.	Depending	on	your
data	and	goal,	you	may	want	to	make	some	formula	adjustments.	The	formula	above	includes	in	the	count	the	number	of	cells	that	match	the	value	exactly.	Like,	the	full	cell	value	is	equal	to	the	value	we	are	seeking.	But	you	may	want	other	counts.	Count	cells	with	a	partial	match	You	may	want	to	do	a	partial	match.	This	is	where	we	want	to	count
the	cell	if	the	value	in	C6	is	found	anywhere	within	the	cell.	In	other	words,	it	doesnt	need	to	be	an	exact	match,	it	can	be	a	partial	match.	That	way,	jax	would	still	match	when	x	is	the	value	to	find.	If	so,	simply	update	the	C6	argument	from	C6	to:	"*"	&	C6	&	"*"	Placing	the	asterisk	wildcard	characters	around	the	cell	value	tells	Excel	that	the	value	in
C6	can	be	located	anywhere	within	the	cell.	We	use	the	concatenation	operator	&	to	join	the	wildcards	to	the	cell	value.	So	the	updated	partial	match	formula	would	be:	=COUNTIF(B12:B21,	"*"	&	C6	&	"*")	Count	number	of	occurrences	If	youd	like	to	count	the	number	of	times	that	the	individual	letter	is	found	in	all	of	the	text	in	all	of	the	cells,	we
can	create	a	helper	column	next	to	the	range	like	this:	=LEN(B12)-LEN(SUBSTITUTE(B12,$C$6,""))	We	can	then	fill	this	helper	column	down:	And	then	we	can	just	sum	up	the	helper	column	values	to	determine	the	number	of	times	that	character	is	found	within	the	range.	Now,	what	if	we	wanted	to	do	this	within	a	Table,	and	highlight	it	with
conditional	formatting.	That	leads	us	to	the	next	exercise.	Now	that	were	familiar	with	the	COUNTIF	function,	lets	explore	how	to	use	Excel	Tables	and	Conditional	Formatting	to	better	visualize	our	data.	If	youve	yet	to	make	the	most	out	of	Tables,	dont	worry	transforming	an	ordinary	list	into	a	Table	is	a	breeze.	Simply	select	any	cell	on	the	range
and	click	the	Insert	>	Table	command.	To	display	the	count	of	the	number	of	matching	cells	in	our	Table,	well	use	our	trusty	COUNTIF	function.	Our	List	column	contains	the	values	we	would	like	to	count:	We	can	generate	the	count	of	the	number	of	cells	that	match	the	value	in	the	cell	to	the	left	by	writing	the	following	formula	into	the	Count
column:	=COUNTIF([list],	[@list])	We	hit	Enter,	and	bam:	Note:	since	this	formula	is	written	inside	the	Table,	we	dont	need	the	Table	name	prefix	in	our	formula.	We	can	just	use	the	column	name.	To	highlight	the	values	that	exist	more	than	a	given	number	of	times,	we	can	apply	Conditional	Formatting.	Just	select	the	entire	Count	column	and	select
Home	>	Conditional	Formatting	>	Highlight	Cell	Rules	>	Greater	Than.	In	the	resulting	dialog,	enter	your	desired	value	and	formatting:	Click	OK	and	bam:	But,	what	if	you	dont	want	to	have	to	scroll	down	the	Table	to	locate	the	matching	the	cells.	What	if	instead,	you	wanted	to	pull	the	values	that	appeared	more	than	twice	out	of	the	Table	and	into
a	concise	list?	Well,	that	brings	us	to	our	final	exercise.	Now,	lets	say	we	need	a	separate	list	of	the	values	that	appear	more	than	2	times.	This	is	where	we	can	use	the	FILTER	and	UNIQUE	functions.	Combining	these	functions,	we	can	generate	a	unique,	dynamic	list	of	values	that	occur	more	than	twice	in	our	initial	list.	Well	break	the	formula	into
two	steps.	First,	we	need	to	understand	how	the	FILTER	function	works.	It	returns	a	subset	of	a	range.	The	range	will	be	our	list	values,	and	the	subset	of	it	will	be	those	with	a	count	greater	than	2	(or	whatever	number	you	are	after).	We	write	the	following	formula:	=FILTER(Table1[List],Table1[Count]>2)	And	bam:	Note:	since	this	formula	is	written
outside	of	the	Table,	we	need	to	include	the	Table	name	prefix.	That	formuls	returns	a	list	of	the	values	found	more	than	2x.	But,	the	result	contains	duplicates.	We	can	remove	the	duplicates	with	the	UNIQUE	function.	We	simply	wrap	it	around	our	existing	formula	like	this:	=UNIQUE(FILTER(Table1[List],Table1[Count]>2))	Hit	Enter,	and	bam:	And
voil!	With	these	handy	techniques,	we	can	identify	and	highlight	values	that	pop	up	multiple	times	in	our	data.	I	hope	this	post	is	helpful,	but	if	you	have	any	follow	up	questions,	suggestion,	or	alternatives,	please	share	in	the	comments	section	below.	Thanks!	Download	the	sample	file.	CFItemsXTimes.xlsxDownload	Q:	How	does	COUNTIF	function
work	in	Excel?	A:	The	COUNTIF	function	in	Excel	is	used	to	count	cells	that	meet	a	certain	criterion.	Q:	What	are	Excel	Tables?	A:	Excel	Tables	are	a	structured	range	of	cells	that	allows	for	easier	data	management.	Q:	How	do	I	apply	Conditional	Formatting	in	an	Excel	table?	A:	Select	the	cells	you	want	to	format,	go	to	Home	>	Conditional
Formatting	>	Highlight	Cell	Rules	>	and	select	your	desired	option.	Q:	How	does	the	FILTER	function	work	in	Excel?	A:	The	FILTER	function	is	used	to	filter	a	range	of	data	based	on	certain	criteria.	Q:	What	does	the	UNIQUE	function	do	in	Excel?	A:	The	UNIQUE	function	gives	a	list	of	unique	values	in	a	range	or	array,	eliminating	any	duplicates.	In
another	handy	tip,	AccountingWEB.coms	David	H	Ringstrom	explains	how	to	use	conditional	formatting	as	an	aid	for	financial	and	performance	analysis.Identifying	variances	that	exceed	particular	limits	are	the	bread	and	butter	of	accounting.	But	approaching	this	task	by	running	your	eye	down	columns	of	numbers	can	be	mind-numbing	and	prone	to
oversights.Excel's	conditional	formatting	capability,	can	make	such	variances	leap	out	at	you	from	the	screen.	This	article	will	show	how	to	use	this	technique	to	identify	budget	variances	both	by	dollar	value	($2,000+/-)	and	pecentange.Conditional	formatting	does	have	some	quirks	that	can	frustrate	novices.	The	easiest	way	to	apply	the	formatting	is
often	to	specify	the	conditions	you	want	to	apply	to	a	single	cell	and	then	use	Excel's	Paste	Special	Formatting	feature	to	replicate	the	formatting	across	the	cells	you	want	to	analyse.	Note	that	formula-based	conditional	formatting,	as	shown	below,	often	won't	return	the	desired	results	when	you	attempt	to	apply	it	to	multiple	rows	or	columns	at	once.
Below	is	a	typical	actual-versus-budget	comparison.	We	are	going	to	apply	yellow	highlighting	to	any	variances	of	more	than	$2,000	or	10%.	In	example	shown,	rows	will	only	be	highlighted	when	both	tests	are	met.	The	step-by-step	sequence	is	illustrated	using	Excel	2007	and	will	work	for	later	versions,	but	there	will	be	a	brief	summary	of	how	to
achieve	similar	results	in	Excel	2003.1.	Excel	2007	and	later:Click	cell	D2,	choose	Conditional	Formatting	on	the	Home	tab,	and	then	click	New	Rule,	as	shown	in	Figure	1.Excel	2003	and	earlier:Click	on	cell	D2,	choose	Format,	and	then	Conditional	Formatting.2.	Excel	2007	and	later:Choose	Use	a	Formula	to	Determine	Which	Cells	to	Format,	as
shown	in	Figure	2.Excel	2003	and	earlier:Change	Cell	Value	Is	to	Formula	Value	Is.3.	All	Excel	versions:Enter	this	formula:=AND(ABS($D2)>2000,ABS($E2)>0.1)4.	All	Excel	Versions:Click	the	Format	button,	choose	Fill	tab,	click	the	desired	colour,	such	as	yellow	shown	in	Figure	3,	and	then	click	OK	twice.5.	All	Excel	versions:Select	cell	D2,	click
the	Format	Painter	as	shown	below,	and	apply	the	formatting	to	cells	D2	through	E10.	The	Format	Painter	appears	on	the	Standard	toolbar	in	Excel	2003.6.	All	Excel	versions:Reapply	the	percentage	number	formats	in	cells	E2	through	E10,	as	shown	below.	Excel	cannot	replicate	conditional	formatting	by	itself	without	overwriting	the	existing
number	formats.	Its	much	easier	to	get	Conditional	Formatting	right	by	applying	it	to	a	single	cell	first,	and	then	copying	any	number	formats	as	required.If	you're	using	Excel	2007	or	later,	you	can	now	right-click	on	one	of	the	yellow	cells,	choose	Filter,	and	then	Filter	by	Selected	Cells	Color,	as	shown	below.	You	can	also	sort	by	colour	as	well	in
Excel	2007	and	later.This	illustration	shows	the	filtered	list.	To	remove	the	filter,	click	the	Filter	icon	on	the	Data	tab	in	Excel's	menu	known	as	the	Ribbon.If	you	are	keen	to	apply	this	technique	in	similar	situations,	here	are	some	pointers	about	the	formula	applied	in	this	example:The	ABS	function	returns	the	absolute	value	of	a	number	-	in	other
words	($17,396)	converts	to	$17,396.The	AND	function	allows	you	to	test	for	up	to	255	conditions	at	once.	In	this	case,	I'm	testing	for	the	absolute	value	of	the	variance	in	column	D	being	greater	than	$2,000,	and	the	absolute	value	of	the	variance	percentage	in	column	E	being	greater	than	10%.	If	both	tests	are	true,	then	conditional	formatting	will
be	applied.The	dollar	signs	before	the	column	letters	make	the	cell	references	absolute	and	are	crucial	when	using	conditional	formatting	in	this	way.	Because	the	format	is	effectively	being	copied	and	pasted	to	a	second	column,	if	the	absolute	references	(eg	$D2)	are	left	out,	Excel	will	adjust	the	references	and	the	conditional	formula	won't	return
the	correct	result.Other	ExcelZone	management	reporting	tutorials	"Either	you	work	Excel,	or	it	works	you!"	saysDavid	Ringstrom	CPA,	the	head	of	Atlanta-based	software	and	database	consultancy	Accounting	Advisors.	He	presentsExcel	training	webcastsfor	CPE	Link	andcontributes	articles	on	Excel	to	AccountingWEB	and	Microsoft	Professional
Accountant's	Network	newsletter.	Hecan	be	reached	by	email	at	david[AT]acctadv.com.	You	can	findfurther	ExcelZone	tutorials	from	David	H	Ringstrom	here.	In	todays	Excel	University	blog	post,	were	going	to	explore	the	incredible	combination	of	the	Conditional	Formatting	and	Data	Validation	features	in	Excel.	I	was	recently	asked	the	following
question:	How	do	I	highlight	matching	customers	on	one	worksheet	based	on	the	customer	selected	in	a	data	validation	drop-down	list	on	another?	And	Ill	answer	this	question	in	this	post.	With	Excel,	highlighting	specific	data	based	on	choices	made	elsewhere	isnt	as	tricky	as	it	sounds.	Lets	break	this	down	into	a	step-by-step	walkthrough	using
three	exercises	that	highlight	the	key	ingredients:	data	validation,	defined	names,	and	conditional	formatting.	Well	start	by	setting	up	a	data	validation	drop-down	list	so	we	can	select	a	customer.	Lets	say	your	list	of	customers	is	in	a	range,	like	this:	You	can	create	a	drop-down	list	in	a	cell	to	enable	the	user	to	pick	one	from	the	list.	To	create	the
drop-down,	select	the	desired	cell	and	then:	Data	>	Data	Validation	Select	Allow	List	Select	the	range	of	of	choices	in	the	Source	field	The	resulting	dialog	should	look	a	bit	like	this:	Hit	OK,	and	now	you	have	a	drop-down	in	the	cell:	With	the	Data	Validation	drop-down	complete,	we	can	move	to	the	next	exercise.	Bonus	If	you	dont	have	a	unique	list	of
customers	as	shown	above,	you	can	have	Excel	create	it	for	you	based	on	transactions	in	the	workbook.	One	option,	which	would	be	good	if	the	customer	list	is	relatively	static,	is	to	copy/paste	the	customer	name	column	from	the	data	transactions	into	a	single	column	and	then	use	the	Data	>	Remove	Duplicates	command	to	remove	duplicates.	You
can	also	sort	them	by	using	Data	>	Sort.	Another	option,	which	would	be	good	if	the	transactions	are	stored	in	a	Table	and	you	want	Excel	to	update	the	list	each	time	the	Table	data	changes,	is	to	use	the	UNIQUE	function	on	the	Tables	Customer	column,	like	this:	=UNIQUE(TableName[ColumnName])	To	use	these	results	in	the	drop-down,	we	use
data	validation	to	create	a	list	with	a	source	of	=$A$1#.	Note	the	spill	operator	#	follows	the	absolute	cell	reference	which	points	to	the	cell	that	contains	the	formula.	You	can	also	sort	the	list	returned	by	the	UNIQUE	function	by	wrapping	a	SORT	function	around	it,	like	SORT(UNIQUE()).	Note:	the	UNIQUE	and	SORT	functions	are	not	available	in
all	Excel	versions.	To	easily	reference	the	customer	selected,	were	going	to	assign	a	name	to	the	cell	that	contains	the	drop-down.	Heres	how:	Select	the	cell	Navigate	to	the	Name	Box	(it	is	just	to	the	left	of	the	formula	bar)	Type	in	the	desired	name,	like	Customer,	and	avoid	spaces	and	funky	characters	Hit	Enter	Now	that	our	cell	is	named
Customer,	we	can	refer	to	the	cell	via	this	name	within	our	formulas.	With	the	drop-down	created,	and	the	cell	named	Customer,	it	is	time	to	head	to	the	next	exercise.	Now,	moving	on	to	the	main	step	setting	up	conditional	formatting	based	on	the	selected	customer.	Once	a	user	selects	a	customer	from	the	drop-down,	we	want	transactions	in
another	worksheet	to	be	highlighted,	like	this:	To	apply	such	conditional	formatting	to	the	data	transactions:	Select	the	entire	transactions	range	Home	>	Conditional	Formatting	>	New	Rule	In	the	resulting	dialog,	select	Use	a	formula	to	determine	which	cells	to	format	The	formula	will	compare	each	row	within	the	selected	range	to	the	customer
selected	in	the	drop-down.	This	will	use	a	format	like	this:	=$A1=Customer.	Where	$A1	is	replaced	with	an	absolute	column	that	refers	to	the	matching	customer	column,	and	a	relative	row	reference	that	points	to	the	row	of	the	active	cell.	Customer	is	the	defined	name	that	points	to	the	drop-down	cell.	Note	that	you	create	an	absolute	column
reference	to	the	customer	column	by	preceding	it	with	a	dollar	sign,	like	this:	$A1.	Finally,	set	the	formatting	you	want	applied	when	the	condition	is	met,	and	click	OK.	The	conditional	formatting	rule	will	look	a	bit	like	this:	Voila!	Weve	linked	our	data	validation	with	conditional	formatting.	By	changing	the	customer	selection	in	the	drop-down	list,
Excel	automatically	highlights	matching	customers	on	the	other	sheet.	To	summarize,	Excel	provides	the	convenience	to	combine	conditional	formatting	and	data	validation,	granting	a	visual	way	of	tracking	data	across	worksheets	based	on	the	selection	made.	If	you	have	any	alternatives,	enhancements,	or	questions,	please	post	in	the	comment
section	below	thanks!	Heres	a	downloadable	sample	file	that	showcases	this	powerful	technique:	Q:	Can	I	use	conditional	formatting	with	data	validation	in	other	scenarios?	Absolutely!	While	this	post	uses	the	customer	scenario	as	an	example,	you	can	apply	the	same	principles	in	myriad	ways	in	Excel.	Q:	Can	I	type	my	choices	for	Data	Validation?
Indeed,	in	addition	to	pointing	the	choices	to	a	worksheet	range,	you	can	also	type	a	list	of	choices	just	separate	the	choices	with	commas.	Q:	Can	I	change	the	formatting	later?	Surely!	You	can	change	the	conditional	formatting	rule	and	related	formatting	by	going	to	Home	>	Conditional	Formatting	>	Manage	Rules.	Then	you	can	Edit	the	rule	as
desired.	Q:	Can	I	import	and	use	this	on	Google	Sheets?	While	the	steps	may	differ,	Google	Sheets	also	supports	data	validation,	named	ranges,	and	conditional	formatting.	Your	recent	budgets	had	significantly	high	variances--higher	than	10%.	Your	management	team	will	want	to	know	why	and	they'll	be	asking	questions	such	as:	How	much	did	we
budget	Production	Volume	Costs	for	in	December?What	was	the	difference	between	what	we	budgeted	and	the	actuals?17%--why	is	it	so	high?	What	happened	in	December?You're	the	strategic	advisor.	To	answer	their	questions	and	to	provide	possible	causes,	you	need	to	know	how	to	create	a	variance	analysis	report	in	Excel.	Your	report	should	be
quick	to	create,	easy	to	read	and	visualizes	the	data	to	tell	a	story,	providing	insights	to	your	management	team	to	inform	their	analysis	and	decision	making.In	this	blog,	we'll	cover:Understanding	a	Variance	report4	best	practices	for	writing	a	variance	report	in	Excel3	common	problems	in	variance	analysis	and	reportingWhat	is	a	Variance	Report?A
variance	report	compares	planned	financial	outcomes	with	the	actual	financial	outcome	that	occurred	-	it's	the	difference	between	what	was	budgeted	and	planned	vs	what	actually	happened.How	To	Write	A	Variance	Report:	4	Best	Practices	For	Visualizing	Variance	Data	in	Excel1.	Vertically	Align	Variance	Amounts	With	Budgets	and	ActualsYour
management	needs	to	see	variance	amounts	with	their	respective	budgets	and	actuals--alongside	other	variance	amounts	and	those	respective	budgets	and	actuals.	Only	when	these	variances	are	analyzed	comparatively,	can	they	gain	insights	to	inform	their	decision	making.Some	examples	of	insights	they	may	glean	include:Which	expenses	have	the
highest	cost	increasesWhich	product	lines	have	the	lowest	sales	increasesWhich	territories	have	the	highest	employee	tenure	decreasesTo	vertically	align	variance	amounts	with	budgets	and	actuals:With	your	two	charts	(one	for	variance	amounts,	the	other	for	budgets	and	actuals)	completed,	hold	the	alt	(shift	on	Mac)	key	to	align	your	variance
amount	chart	underneath	your	budgets	and	actuals	chart.Delete	the	title	and	x	axis	labels	from	your	variance	amount	chart.Your	two	charts	are	now	one--one	chart	that	tells	one	story,	and	one	story	that	provides	multiple	insights	for	your	management.Watch	the	videoto	learn	from	Excel	nerd	Chandoo	how	to	vertically	align	variance	amounts	with
their	respective	budgets	and	actuals	to	gain	decision-making	insights.	To	watch	the	full	Advanced	Excel	Charts	for	Finance	Professionals	workshop	on	demand,	become	a	Plan	To	Grow	member	and	join	the	community.	Don't	miss	out	on	mastering	data	storytelling.2.	Apply	Conditional	FormattingNow	that	you've	aligned	your	two	charts	together	to	tell
one	story,	apply	conditional	formatting	so	that	your	management	can	quickly	view	which	variances	in	your	chart	are	adverse	and	which	are	favorable.To	apply	conditional	formatting:Select	your	variance	amount	chart	to	open	the	Format	Data	Series	menu.Check	off	the	Invert	If	Negative	box	(located	under	the	Fill	heading).You	now	have	the	option	to
select	your	two	colors--one	for	negative	values--to	fill	the	bars	in	your	chart	so	your	management	won't	lose	time	to	guessing	which	are	adverse	and	which	are	favorable.Notice	how	you	can	apply	conditional	formatting	to	quickly	distinguish	adverse	variances	from	favorable	variances.	Bonus	Time-Saving	Tip:	Watch	how	you	can	use	this	"secret"	Excel
menu	to	replicate	the	style	of	formatting	from	one	chart	to	another.	3.	Insert	CommentsAfter	applying	conditional	formatting,	answer	your	management's	questions	about	what's	caused	these	variances	by	inserting	comments.	They'll	have	questions--you	know	they're	coming--so	be	ready	with	answers	in	your	report.Some	questions	they	may	ask
include:What's	causing	our	insurance	costs	to	rise	much	quicker	than	projected?What's	causing	our	electronics	line	to	sell	significantly	fewer	than	planned?What's	causing	our	employees	in	Australia	to	resign	so	much	faster	than	predicted?To	provide	possible	answers,	add	comments	by	right-clicking	the	cell	and	then	select	'Insert	Comment.'Your
comments	should	address:What	you	think	has	caused	the	variance.Whether	you	predict	it's	a	trend	or	an	anomaly.Whether	you	believe	it's	positively	or	negatively	impacted	your	company.While	some	organizations	analyze	only	adverse	variances,	it's	important	to	evaluate	favorable	variances	as	well.	That's	because	not	all	adverse	variances	negatively
impact	a	business	and	not	all	favorable	variances	have	a	positive	impact.	While	you	may	already	know	this,	don't	assume	your	management	does.Example:	If	your	Total	Production	Volume	Costs	for	December	saw	an	adverse	variance--17%	higher	than	planned--perhaps	your	sales	were	higher	than	forecasted.	Simply,	it	cost	your	company	more	to
manufacture	that	month	because	your	customers	were	buying	more.	Conversely,	if	your	Total	Production	Volume	Costs	saw	a	favorable	variance--13%	lower	than	planned--perhaps	your	sales	were	lower	than	forecasted.Insert	your	comments	to	get	ahead	of	your	management's	incoming	questions.	4.	Track	Forecasts	With	Thermometer	ChartsAfter
addressing	your	management's	possible	questions,	they'll	want	to	know:Your	company's	performance	up-to-date	performanceWhether	or	not	your	company's	on	pace	to	meet	year-end	goalsExample:	If	an	expense	item	saw	a	favorable	variance--22%	lower	than	planned--does	that	mean	your	company	found	efficiencies	to	save	on	costs,	or	is	a	project
behind	schedule?	The	answer	is	in	your	forecasts.To	illustrate	progress	and	monitor	performance,	create	a	thermometer	chart	out	of	your	budgets	vs	actuals	chart	to	overlap	your	budget	and	actual	numbers.	To	do	this	in	Excel:Right-click	on	your	budgets	and	actuals	chart.Open	the	Format	Data	Series	menu.Drag	the	Series	Overlap	slider	to	100%
(Note:	Ensure	that	your	chart	has	multiple	series	within	one	category.	Your	bars	won't	overlap	correctly	if	your	chart	is	plotting	multiple	categories	within	one	series.	To	verify	this,	right-click	on	your	chart	and	select	Select	Data.	Select	Switch	Row/Column	to	toggle	and	ensure	that	your	Budgets	and	Actuals	are	correctly	listed	as	Legend
entries.)Select	the	Budget	portion	of	the	overlapped	bar.Select	the	Format	menu	tab	at	the	top.Select	'Shape	Fill'	and	then	select	'No	Fill'	to	remove	the	color.Select	the	Format	menu	tab	at	the	top.Select	'Shape	Outline'	and	then	select	the	color	that	matches	the	color	of	the	Actual	bar.Thermometer	charts	effectively	and	quickly	visualize	performance
and	progress	to	track	your	forecasts.	Now	your	management	can	see--instantly--the	company's	up-to-date	performance	and	whether	your	company	is	on	track	to	meet	year-end	goals	or	not.Notice	how	you	can	create	a	thermometer	chart	to	track	forecasts	and	quickly	illustrate	progress.You've	learned	four	best	practices	for	creating	a	variance	analysis
report	in	Excel,	so	now	it's	time	to	find	out	which	common	problems	may	occur	when	analyzing	and	reporting	variances.3	Common	Problems	in	Variance	Analysis	and	Reporting1.	Time	DelayIf	last	month's	books	still	haven't	closed,	you	can't	create	a	report	with	only	fresh	numbers.	You'll	send	an	outdated	report	to	your	management,	from	which
they'll	analyze	and	then	make	decisions--but	it's	already	too	late.	Your	company	needs	to	close	last	month's	books	faster	so	you	can	create	a	timely	report	that	allows	your	leadership	to	make	timely	decisions.2.	Disparate	Data	SourcesWithout	data	integration,	you	can't	identify	causes	of	high	variances	through	a	big-picture	lens.	Sure,	your
management	may	analyze	your	report,	but	neither	you	nor	your	leadership	will	feel	confident	that	data	isn't	missing.	You'll	need	to	integrate	your	data	sources--such	as	your	ERPs,	GLs	and	HRISs--before	you	can	create	a	complete	variance	analysis	report	to	get	the	full	picture.3.	Historical	Budgeting	LogicIf	you	don't	know	how	previous	budgets	were
set,	you	can't	deliver	a	report	with	any	value	to	your	management.	Your	variance	analysis	report	derives	its	logic	from	the	budget,	so	if	each	budget	evolved	from	previous	versions,	you	need	to	know	the	historical	budgeting	logic	and	your	company	needs	to	be	able	to	retain	budget	calculations.	Looking	at	and	understanding	the	progression	of	budgets
and	variances	will	help	you	create	a	historically	informed	report	which	your	management	can	trust.Variance	Analysis	VisualizationEvery	variance	analysis	report	should	provoke	questions.	If	your	leadership	doesn't	ask	questions	about	your	report,	that's	a	sign	that	it's	not	well	visualized.	As	a	strategic	advisor,	how	you	illustrate	your	variance	data
and	create	your	report--in	a	clear	and	easy-to-read	presentation--should	provide	value	to	your	organization,	by	spotlighting	areas	of	improvement	and	subsequent	actions	to	take.Variance	Analysis	SoftwareWhen	you're	inevitably	asked,	"What	happened	in	December?"	by	using	vertical	alignment,	conditional	formatting,	comments	and	thermometer
charts	in	Excel,	you'll	be	able	to	answer	your	management	team's	questions	and	provide	them	with	the	decision-making	insights	they	need.With	Vena's	Excel-based	Variance	Analysis	software,	you	can	automate	your	variance	reporting.	By	consolidating	your	spreadsheet	data	and	automating	the	addition	of	your	actuals	at	the	end	of	every	period,	your
company	can	eliminate	user	errors,	retain	your	calculations	and	distribute	your	variance	analysis	reports	faster.	05-09-2017,06:54	AM	#1	I	have	a	set	of	forecasted	and	actual	dates	for	different	projects.	I	want	to	be	able	to	apply	conditional	formatting	to	the	actual	dates	that	fall	before	the	forecasted	date	(in	green)	and	after	the	forecasted	date	(in
red)	See	the	attached	file	This	is	an	example	data	set	Capture1.PNG	So	it	should	look	like	this	with	the	formatting	Capture2.PNG	Of	course	I	have	about	pairs	of	forecasted	and	actual	dates	and	about	80	on-going	projects.	Ive	created	a	column	with	the	variance	values	and	have	tried	to	create	rules	using	the	variances	as	reference	for	the	formatting.
Where	$BB$5:BB$74	is	the	column	with	the	variance	between	the	pair	of	forecasted	and	actual	dates.	Capture3.PNG	And	where$H$5:$H$74	is	the	column	of	the	Actual	date,	the	column	that	I	want	the	formatting	on	Capture4.PNG	Attached	Files	Dates	Formatting.xlsx	(137.1	KB,	11	views)	Download	05-09-2017,07:16	AM	#2	Welcome	to	the	forum.
To	format	your	table	of	dates,	you	don't	need	the	variance	columns.	Using	your	example	file,	do	the	following:1.	Select	the	range	D5:AN74	(from	the	'Actual	Date	1'	of	'Project	1'	to	'Actual	Date	19'	of	'Project	70');2.	Click	'Conditional	Formatting',	'New	Rule',	'Use	a	formula	to	determine	which	cells	to	format';3.	Enter	the	formula	below	and	choose	red
text	as	the	format:	Formula:	Please	Login	or	Register	to	view	this	content.	4.	Repeat	with	the	formula	below	with	green	text	as	the	format:	Formula:	Please	Login	or	Register	to	view	this	content.	Note	that	neither	of	these	rules	will	format	the	text	if	the	date	is	equal	to	the	forecasted	date.	Change	the	>	to	>=	for	'on	or	after	the	forecasted	date'	or	the
<	to


